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Product Features

Celleste is a comprehensive application for image acquisition and measurement for industrial and physical scientists. It has been
designed to automate and simplify routine image inspection and measurement tasks.

With Celleste, you can.....

Automate and Customize
» Create and display mini-programs (Apps) and macros to automate procedures that you use frequently on the new Apps tab.

Read and Write Image Data
« Read and write image data in all the standard image file formats including, TIFF, JPEG, AVI, and many others.
« Open and view multi-resolution image files, including Leica .scn, Aperio .svs and BigTiff, and extract out images to analyze.

Process and Analyze
» Analyze colocalized channels. Perform parent/child analysis, analyze within specific regions and more.
« Align, tile, or stitch multiple images together

« Extract features with spatial tools that isolate a Region of Interest (ROI) from the rest of the image, or with segmentation tools
that extract features by color or intensity value

Measure and Count

Report and Share



Installing Celleste

Package Contents

Before installing Celleste, please check that you have received everything in your Celleste package:
= Celleste USB Installation Drive

= Celleste USB Licensing Dongle (if applicable)

System Requirements for Celleste

« OS: Windows 7, 8.1 or 10, 64-bit

» Processor: 2.8 GHz Intel quad-core 64-bit processor (Core i7 Series) or better

« RAM: 16 GB memory or higher

» Free Disk Space: Multiple High Speed SATA Hard Disks or SSDs; 8 GB free on installation drive + free space for images (500+GB)
» Graphics Card: nVIDIA GeForce GTX Cards with 4 GB graphics memory & Open GL 4.2 or higher

» USB port required for hard licenses and offline license activation
 Internet Explorer version 9 or higher

 Internet connection required for online services*



Installing Celleste

1. Insert the Celleste installation memory stick into the USB drive
You will see the Installation Start screen. This screen has the following buttons:
 Install Celleste
» Documentation
 Install Demo Images

2. Click Install Celleste 3. Click Next.

In a few moments, you will see the Celleste Setup screen. You will see the Celleste License Agreement.

4. Check the Accept box, and click Next.

j{{‘;—‘CellesteImageﬁmalysisﬁoft‘l.n.rareSSetup El (=] @ j{{‘;—‘CellesteImageﬁmalysisﬁoft‘l.n.rareSSetup El (=] @
End-User License Agreement

Welcome to the Celleste Image Analysis Please read the following license agreement carsfully
Software 5 Setup

The setup will install Celleste Image Analysis Software 5 on LIFE TEC]_H\_DLDE}[ES CDRPDR‘{LTIDN i
your computer. Click Mest to continue or Cancel to ext. END USER. LICENSE AGEEEMENT and LIMITED PRODUCT
WARRANTY

FOR CELLESTE™ IMAGE ANALYSIS SOFTWARE
WVERSION 5.0

MNOTICE TO USER: PLEASE READ THIS DOCUMENT
CAREFULLY. THIS IS THE CONTRACT BETWEEN YOU
AND LIFE TECHNOLOGIES CORPORATION ("LIFE -

[] 1 accept the terms of this License Agreemert

=




Installing Celleste

15! Celleste Image Analysis Software 5 Setup =] @ |23 15 Celleste Image Analysis Software 5 Setup o] @ |

Ready to install Celleste Image Analysis Software 5

ﬁ Celleste Image Analysis Software 5 Setup E\ =] @
Destination Folder

Destination Folder

Where and how would you |

Where and how would you like Celleste Image Analysis Software 5to be insta. .

Install Celleste Image Analysis Software 5to: Click Install to begin the installation. Click Back to review or change any of your installation
settings. Click Cancel to ext.

: - - - Install Celleste Image Analysis Software 5 Program Files to:
|C:'-.Prog|arn Fileg Invitrogen*Celleste 5%

I C\Program Files\nvitrogen'Celleste 5%
Change...
Change...

Install Celleste Image Analysis Software 5 Data Files to:
C:M\UsershPublic’Documents'\Celleste 5 (Shared)

Install Application for: Install Celleste Image Analysis Software 5 Demo Images to:
Current User C:A\UsershPublic\Documents'\Celleste Demo Images

@ All Users

Back || Net | | Cancel Back || nstal | | Cancel

Back || MNet | [ Cancel

5. Click Change if you want to use a different 7. Confirm that the destination is correct. 9. Click the Install button to begin the

location. Click Change if you want to use a different installation.
6. When the path is correct, click Next to location.
continue, 8. When the path is correct, click Next to

continue.



Installing Celleste

! Celleste Image Analysis Software 5 Setup = B j4) Celleste Image Analysis Software 5 Setup Lo o et

Installing Celleste Image Analysis Software 5

Completed the Celleste 5 64-bit
installation

Please wait while Celleste Image Analysis Software 5 is installed.

Click the Finish button to exit.

Status:

The final installation screen indicates that Celleste is

: 10. Click Finish to conclude the installation process.
now installed.



Activating Your Celleste License

USB license holders must activate their licenses after installing the software and plugging in the hardware key.
1. If you have an Celleste hardware key, attach it to a USB port now.

2. When you first start Celleste, you will see the following dialog:

3. Click Activate Now to activate your license.

This will load the License Activation Wizard which will guide you through the steps of activating your software.

Celleste I

age Analysis Softws
Welcome to the License

Activation Wizard

!
A Celleste Image Analysis Software has not been activated yet, the trial
license is still valid for 8 days.

If you have received a hardware dongle, please plug itin. —

\Would you like to achivate Celleste Image Analysis Software now, or would
you prefer to be reminded sometime later?

Thes wizard wil guide you through the activation of your
bcensa

In order 10 activate your kcense the wizard wil determine the
type of beense required for your soltware and collact the
rformation necessary to enable &

Activate Now Remind Me Later To continue. chick Next

| Next > | I Cancel

1. Confirm your license type and USB dongle.

2. Enter the Unlocking Code(s) that was sent with the product.

3. Provide standard registration information.

4. Once your information is received, all your licenses will be installed on

your machine.



Activating Your Celleste License

=

About Celleste Image Analysis Software l = Lih_J

The About page should show your (non-evaluation) license key:

redits Siroterm [rdermmatioe T
[ 3 3 ENses

AL —rl il L o L =’ oLl [

About

Celleste Image Analysis Software

PEETTERA B S T This page will indicate if and when your license expires.

Imvitrogen
Copyriait® 2018 Invitrasen by Thermo Fisher Seienifc It also provides information about your maintenance package, if any.
MWetwork License Ends: 1216/2015

Mo Registered Maintenance

Sena Mumber: FOR INTEEMNAL USE OMLY

Madules:
Pdhvanced 3D
Large Volume
Deconvolution

G PU Deconvolution

Advanced 30 Display

Close

L N e o~ ,



Getting Started: Celleste Image Analysis Software Workspace

The Celleste Application Window

File Menu Quick Access Toolbar

Celleste Image Analysis Software - Welcome
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Getting Started: Celleste Image Analysis Software Workspace

Celleste displays your images 1n tabbed workspaces, as shown here:

velcome € | |2 Red TRITC 10.tif € ' [« Blue DAPI 10tif € | |&d Green FITC 10t €

The name of the active image in the workspace 1s highlighted. You can switch back and
forth among multiple images by clicking the image’s tab.

The small icons next to the name of the 1mage indicate what type of image 1s open. Some
examples of common types are shown here:

‘JRed TRITC10.UF 0 & chromo.seq @ 15715 HGF LAMP488 4 ©)

Single image .
vie;: 3 3D view Multi-channel view



Different Types of Content

Celleste is able to open and save a wide variety of files and formats

All Image Set Files (*.mcs, *.ips, *.deb, *.avz, *.czi, *.dm3, *.dmd, *.dv, *.oib, *.oif, *.ics, *.lei, *.Iif_ s, *.nd, *.nd2, *.ndpi, *.ndpr, *.ndpis, *vms, “wmu, *.scn, *.seq, stk
Aperio Virtual Slide (*.svs)

AutoQuant Legacy Sets (".deb, *.avz)
Bitmap or Micro-Manager (*.te)
Deltavision (*.dv)

FITS (* fits, *fit, *.fts)

Gatan Digital Micrograph (*.dm3, *.dmd)
Hamamatsu ManoZocmer Image (*.ndpi, *.ndpr, *.ndpis, *vms, *vmu)
Irnage Cytometry Standard (*.ics)
Irnage-Pro Plus Sets (*.ips)

Irage-Pro raw (*.ipraw)]

JPEG Image (*jpg, *jpe, *jpeg)
JPEG2000 (*jp2, *jpf)

Leica LET (*.lei)

Leica LIF (*.1if)

Leica SCM (*.=cn)

Media Cybernetics Experiment (*.mce)
Media Cybernetics Sets [*.mcs]

Meta MD (*.nd)

Meta STE (*.stk)

Movie Sequence (*.5eq)

MPEG 4 Files (".mpd, ".mov, *.mdv)
Mikon Elements MDZ2 (*.nd2)

Objective Imaging Workspace [*.5ws)
Olyrnpus FluoView 1000 (*.cib, *.oif)
PerkinElmer (*.tirm)

Portable Metwork Graphic (PMNG) (*.png)
TIFF (*.tif, *.tiff, *.btf)



The Celleste Ribbon

The File Menu

List of commands

Ne
1. Tumor.tif
@ C\Users\Public\Documents\Demo Images\Color\Tumor.tif i
Open ’
2. OTOLITH.TIF
& pd Save , | C\Users\Public\Documents\Demo Images\Line Profile\OTOUTH.TIF

@Save As \
L-:Js_eloac

6 Print ’

la]glose

Recentdocuments

@ Options £J Exit

The File button is located in the upper-left corner of the application window.
The File button menu contains commands that operate on the document as a
whole, such as Print and Save, as well as other basic functions.

|
B
)

EES:WE As
@E&Ioad

ﬁ Print v
Qlose

Recent Document=
1. FPRINT2.TIF

,|Open image files

Open Images

@ Cpen one or several image
files.

Open Images as a Sequence
@Build a sequence by

combining several image

files.

Open Set from Files
@Build animage set by

combining several image

files or sequences,

Open Set from Folder
@Build animage set by

combining several folders of

image files.

Open Demo Images

! Open image files from the
demo folder.

#.1 64-bit (Shared)\Demo Images\Filter\Sharpening\FPRINT2.TIF
L1 64-bit (Shared)\Demo Images\Filter\Sharpening\BANKVID.TIF

=
L1 64-bit (Shared)\Demo Images\Filter\Rice.tif

£ Options [k Exit




The Celleste Ribbon

ETE

? Home | Adjust Process Select Count/Size Measure Share View Automate Apps
Dye ||z (none) v itk Iﬁ‘* ? &2 j. IQ it
Lens ﬁ (none) g Image Line Saturation | Analysis Publication Movie
Histogam Profile v - - v
Optical Characteristic [ Intensity Quick Save
Home tab

The Home tab contains groups for selecting dyes and lenses, calibration, and saving your images.

B De. sl

[ . | - .
Home \ Adjust | Process Select Count/Size Measure Share View Automate Apps
" =] =] Al C B
D - =1 Mono8bpp ~ s ® [ 7‘—1 lpest > -o——U———3 50| BL: 0K WAICh ~ l ~/
. ' ety |l CE————@)| soR we 255 2 ) [
Resize Rotate Canvas 3App|w ~ | Extract Merge Dye/Tint Composite Pseudo = = "TA:.‘ — = Advanced
- v v et L v v v . v Oo——U—® = HiBestfit v+ W = [
Seomet e Salr il R il

The Adjust tab contains all the functions that allows you to manipulate the image for best viewing and interpretation.
Some functions may require making new or composite images from other images or changing the pixel values within an image.

B 1Se . s
Home Adjust | Process | Select Count/Size Measure Share View Automate Apps

E = @ % E.-;i: L ‘gg__] 4 Subtract ~

jCorred ~

Merge Subsample Align EDF Tiling HDR  Image _
Files - - v ~  Compare | &% Optiors ~
Combire | Background |

Process Tab
The Process tab contains the image processing tools that allow you to change an image or extract information from it.




The Celleste Ribbon

B Sl s
Home Adjust Process | Select \ Count/Size Measure Share View
-

" \ Paste ~ ! 20 . X o <] . b .

Automate Apps

&

| Copy ) 2!
- W S _~ Optiors | "~ MagicWand Validate | 4o sz 2.8 U Display
@& Paste New ThCrop | % 8 D i - B v - A - ~ | Optiors
Clipboard Regions of Interest | Magic Wand | Annotate 1

Select Tab
The Select tab contains the Clipboard, Annotation, ROI, and Mask features that enable you to examine and

annotate an image or part of an image.

S sl
Automate Apps

Home Adjust Process Select \ Count/Size ‘ Measure Share View
Wsingle

) ot > @ B — x
Bright & Manual t'[ ééj 3] z &Tb @ (":“‘_Q‘ zz @ o ~DataTable | Clos< 1
et ¢ | jyData Histogram Apply @ B @ | Fiearning Total 0

r, s Count Split @ Types Edit |[Ranges| Optiors : W S ;
@ oarc Ay smart . . «  Range & ObjectWindow | @& “% |shape & =~ - | “Wauo g - [NRange 0
Segment | Count | Split | Measuremenis [ View | Select Class | Classify [ Count Results [

Count/Size Tab
The Count/Size tab contains tools that allow you to view, count, and measure objects in a two-dimensional image.

It also contains the tools to display the resulting data in a variety of formats.

B iSel s

IS
Home Adjust Process Select Count/Size ‘ Measure ‘ Share View Automate Apps
@ @ o el | B SN - . . ¢+ . Wopatatable Class 1 - r ! x E ¢ TlpataTable |iHistogram
) IS % y = = I~ ! .
Data Histogram Apply 4 - ) 'F1Block =) Scatter
Types Optiors Qj A 7 = / Snap F o owtN L. . A Rol Line Create Collect Types ? 8 bt
= | o = TasT - ¥* T A¥ | g objectWindow |Shape &~ [~ | profie - - ¥ . (@ [Reraph & 3o
Measuremenis Select Direct | Edge | Best Fit [ View | Class | Caliper | Colocalization| Data Collector

Measure Tab
The Measure tab contains features that enable you to measure and analyze features in all or part of your two-dimensional image.



The Celleste Ribbon

N o ] | % & LI

evie

=
’

4 Tl DataTable |l Histogrem & Pie Chart
. . . . E E Block I.i Scatter
View PowerPoint | Images 1lImage perPage Edit Template  Aucdit Colled Types
- - - Trail . - u E Graph [B 3D
Expart Repaort Audit Trail Data Collector
Review Tab

The Review tab contains features that allow you to share your images and data with others. You can also create an
audit trail of all the recordable events during your image processing session. The features on the Review tab allow
you to create reports and export your files.

¢ &

Image | File Browser Browser
Strip -

@ =2 !

MDI  AlignViews  Full
- - Screen

Close Al Closs Al Took Show | Marker
Views Toolks - - -

Waorkspace Data Cwerlay

View Tab
The View tab contains specialized tools and graphs to display information about the active image or image set. Some of

these tools allow you to see different aspects of the active image also.

|=] Image

[ & 525 == e 5 @ -
o S }w\ ::: F"’ "l' :3-1 157 = &/JS‘ a @

Image | Surface Gallery Slicer 30  Bitmap Clone | Zoom  Pan Local Lock
- Zoom -

Views Zoom

Image Tab
The Image tab is only visible when there is an image or image set open in the workspace. You can adjust the image display,

show it in a gallery, or zoom/pan on a particular portion of the image.



The Celleste Ribbon

Automate

/| @

Project Explorer Project Mew Record Pause
- Workbendh | Projed Macro Recording

Macros

Automate Tab
The Automate tab contains the macro scripting features. This tab is visible by default, but you can turn it off by un-
checking Show Automate Tab on the Display options page.

Apps
@ o
®e }(
Open
Project Particles Fibers
Search Apps
Apps Tab

The Apps tab contains any apps that you have loaded into your copy of Celleste. It is empty until you have created or
downloaded some apps.



Basic Tools



Using Annotations

Annotations are used to add text or drawings to your images. The annotations are in a graphics overlay that is displayed over the
image without modifying the image data itself.

Creating an Annotation - || Chapter 6: Using Annotations
R— f— "/ Circle [d The Select Tab
o - - a - = = )
=‘:E'~= — l@ ", Cross45’ D Creating an Annotation
| . Display = Cross9r v [ Creating a Graphical Annotation
Optiore e e
-ross e [l Annotation Shapes
Annotate > Diamord
e D Creating a Text Annotation
Square
D Inserting a Bitmap Annotation
Star
D Arranging Annotations
Target 45°
D Moving an Annotation
Target 90"
D Rotating an Annotation
Triangle Down
D Resizing/Reshaping an Annotation
Triangle Up
D Grouping Annotations
Hand
[l Ordering Annotations
Arrow
[l Deleting an Annotation
Rocket
Trianale D Setting the Appearance of Annotations
Arromhesd v D Changing the Appearance of an Annotation



Making Measurements
- R.. 8 e &
% ’{g M 'f‘g‘ Qﬂ Data Measurements

el Celleste offers you a variety of measurement types to analyze your images. These appear in the
Types Edit |Ranges Optiors _ Measurements group on the Count/Size ribbon as well as on the Measure ribbon
- Range
‘ Measurements ‘
Available Measurements . Selected Measurements /Filters ——— X | M
[aiTypes RlAiceemre [ [men - [ ¥ Wesmronen -~ w1 To se_lect your measurements, follow the ste|_os below. _
- Ange - © = Fontacaton X 1. Click the Types drop-down arrow. You will see the Measurements dialog:
E Angle = Oﬁdd Al n Une:Length
E Certer X Angle:Angle .
@ Lobe B Region rea 2. Using the Add or Add All buttons, select the measurements you want
e ‘1 Fedue () Remove to make. The Available measurements list contains the measurements that
Vi Distomos B Clear can be grouped by Measurement type (All Types, Regions, Lines, Points,
P08 Voan Distance Best-Fit, Angles) and Measurement
Mir Distance ]
57 e Category:
=l Line bl "




Making Measurements

Edit Ranges
Adjusting filter ranges interactively can be done using the Edit Range button:

Edit Measurement Range LdE-J
BN Region:Ares - [Bins | 161 EJ Lo fee
Min Max

40

20

0

100 200 300 400 500 600 70O =00 900 1000 1100

Active Min 10k
{3) Reset Max 100000000 154(| «* Apply Filter
Objectsnrange 13129 | sy cncloss | Ok | [ Cancal_]
Measurements Optiors o
Segmentation Optiors
Connectivity : EEE g-connected * &9 Lload
B .
== =
Clean Borders: i_j MNone < ‘?J,Save
Fill Hales Smoathing 0=

Auto-Threshold : | MinVariance

Connectivity, either 8-connected or 4-connected, defines the number of pixel
neighbors segmenting the objects.

Clean Borders specifies if the objects touching the selected borders will be
eliminated from the result

Fill Holes option indicates if the holes inside objects should be included into
the object area.

Smoothing defines the degree of smoothing used for the object outlines. When
the default value of zero is set no smoothing is applied.

Segmentation bias automatically adjusts the calculated threshold values by the
given bias value. More about segmentation bias appears later in this chapter.
Grow defines the size increment (in pixels) of segmented objects that is applied

after a Count operation using dilation or erosion of the segmented regions.



Making Measurements

Manual Measurement Tools

Select Object Show/Hide objects
\ — and measurements
Delete selected object I—\ - /—1 Delete all objects
N 38/
5
o,
Select
Measure Line

Manual Tag Ih-g.m v &-_
Circle |'_- O - C] - A_ =

AI Pitch af line

/Direﬁ

\1 ."i ng—lg

Polygon |/

Best-fit measurements

g€ -
Best-fit measurements can be used to
create features from a number of manually
_Zﬁ? - w placed points.

est Fit

Relative Measurements

The Relative Measurements group provides tools to create

measurements between existing features. You have to create one or
more objects first, and then create a derived measurement.



Count objects and cells
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Process
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Count objects and cells
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Count objects and cells

Rename

| = = ImageTonIsl | | e
m Home Adjust Process Select Count/Size Measure Share View [=] Image Automate Apps O -
— y . & ot = T Table - Sinale
;,‘farigl-.t|f- Manual| (723] x :;':‘9 f’ " @ o DataTable - Class 1 single
’ e " | &8 | jwDataHistogram Apply &t ¥ Learning Total 0
e’/D R Count Split Types Edit |Ranges || Optiors . ) In R; o
ar oy M3 - = - Rangs & | & ObjectWindow shape & - - Auto & v HUELS
Segment Count Split Measuremenis View Select Class Classify Count Results
Image Strip B > [welcome ©"|=_|A549 0.6um Live Dead NBL 10X Plate R p0_0 DO7f00d0.TIF 4 p Measure o
Threshald Toal [=] =
Class1 [ (N | '|:;|Show -|W e ;
@ Count | @ L |
Celleste {

invitrogen

0 TheTE b Sk

Click to count

_| ‘-fg: Measurements Optiors || E_ Measure

| Mone: 75 | S.Calib: um (A549 0.6um Live Dead MBL 10X.2017-02-08-17-48-35 Imace 0) | © | (] & 232

| Frame:1/1 | 2561-11-0609:50:14.842 | X¥:1116, 26 e ||t 50% | (F——l—(F)



Count objects and cells
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Count objects and cells
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Work with Regions of Interest (ROI)
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Counting Multiple Classes
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Immunohistochemistry Analysis
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5. Use Smart Segmentation to segment the nuclei.

Cell Viability-Live/Dead cell analysis T e T I ———
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The blue nuclei in the d0 image will give the total cell count. @ k 6
The green nuclei in the dlimage will give the dead cell count.
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6. Set following Count and Size parameters:
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Cell Viability-Live/Dead cell analysis

10. Open Features Manger located in the Select Tab. If the Features Manger is
hidden, right mouse click in the Select Ribbon and turn it on.

7. Measurement Types: Object: Class Name, Region: Area, Region: Intensity Mean
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loodo.TiF* @ (|« hela_BG_low_Piate_f A , 43 Measurementsin » | New collection }Or
] Save measurement options to — —
file
Feature collections:




Cell Viability-Live/Dead cell analysis

15. Press the Learning Classification Button in the Classity Group.

13. Press the Set Feature to Image Button to transfer the nuclei outlines to the d1
active image.

Wsingie

L Total

o Learring

Total Cells
Features Manager R
i .' ",A—fl -

Q ¢ Class Classity

Shage & In Range

Cound Resulls

ff"f)OJen - E Save v
7 Cp -

Features Manager

() Add ~| €

Fe

eature collections ,1),, -~
=} hela_BG_low_Plate_R_p00_0_HO08f00d0.TIF o |9
~|:Region Measurements  Measurements - |, 3
/Z, Polygon (37, 3-62, 27) o [
/Z, Polygon (173,5- 194, 23) o |
/Z, Polygon (606, 6 - 623, 30) ol 1K
/7, Polygon (542, 9 - 567, 29) o €
/Z, Polygon (577, 9 - 600, 39) o 9%
/Z, Polygon (130, 10- 144, 31) o |
/Z, Polygon (481,10 - 499, 32) ¢ |98
/Z, Polygon (146, 13- 161, 30) o %

Nuclei Measurement Outlines

12. Select the hela_BG_low_Plate_R_p00_0_A08{01d1.TIF image and make it the

active image.

ure collections

Fe;

(8 1)
.

-| Region Measurements

£Z Polygon

u Add " \f\/} Open ~ E Save v
e &
=} hela_BG_low_Plate_R_p00_0_HOSf00d0.TIF u

(37.3-62.27)

Measurements |~ g 3K

Set feature to image h

/Z Polygon (173,5-194,23) 1g/o8]
/Z, Polygon (606, 6 - 623, 30) o) (X
/Z, Polygon (542, 9 - 567, 29) o) X
/Z Polygon (577, 9- 600, 39) k) X
/Z, Polygon (130, 10 - 144, 31) | K
/Z Polygon (481,10 - 439, 32) o) X

Transfer Nuclei Outlines

14. Select the Count/ Size Tab.

Learning Classification

1 hsna-{Snve

VHE e

2_Define classes and add reference objects

7 Add Class

3. Classification Measurements
\JAdd Al | () Reset
v

Measurement
B Regianaces
Reglon:ntensity, Mean
2 Y.

B regionintensity, Sta Dav

4 Classifiers
z Calculate classifiers [¥] Auto weight

5. Classify

Learning Classification

0.0000
0.0000
0.0000




17. Select one or two Live Cells which do not contain any fluorescence from the d1
green image. Press the OK Button when done.

Cell Viability-Live/Dead cell analysis

Count/Size [ e oronce oty o B chven s Auto
o {Cﬂ % = ells
16. Press the Add Class Button. Rename Class 1 to Live Cells. v 3 ly & &

Ranges | Optio

oe | | oK || cancel | [& - I

Leaming Classification I&l Measuremeris > £ TTE seTeCT " Class
- TT—
D AR L |-_|hela_BG_low_Plate_R_p00_0_HO8f00d 1.TIF ©

¢ =

. |W
2_Define classes and add reference objects
&J Add Class

|1 8. Press the Add Class Button and add another class. Rename Class 2 and name the
class Dead Cells.

Adding a Class of Objects

Press the Select Reference Objects Button. . « .
] Learning Classification L-;h___J

Learning Classification o 1.Trainand Save —
= —
1. Tramn and Save - PO - | - I {

v 8 LA ‘l- =3 =
2 Define classes and add reference objects 2. Define classes and add reference objects ————
%/ Add Class

&/ Add Class

C1a um » kY K = i
iLive Cells| g ’ 0 @ X U«*‘" -1ass ‘uim a‘ R U K
| , Live Cells 2 & k () A
Select reference objects onimage PR M 0000 ¢ 00 mwm raat T H
. :Dead Cellsl 0 k I K

Adding a Second Class of Objects

Naming and Selecting Reference Objects : A : :
g g ) 19. Press the Select Reference Objects Button and add reference objects that are

positive for tfluorescence from the d1 image.



Cell Viability-Live/Dead cell analysis

20. In Section 3, press the Add All Button to select all measurements as shown in the
screen shot below.

— —_

Learning Classification

1. Tram and Save
PHE 8@
2. Define dasses mdaddleferemeohecls =

Class Num >

| LAY
Live Cells 2 @ k(Y X
Dead Cells 2 R Iy A

‘3. Classification Measurements
) Add All | () Reset

v Measurement Weight
¥ Region:Area 0.0000
‘ m Region:Intensity, Mean

0.0000

Selecting Classification Measurements

21. InSection 4, press the Calculate Classifiers Button.

4_Classihers

& Calculate classifies (¥ Auto weight

5. Classily
| Calculaie classihiers

Calculate weights of
' classification measures. The
~Ly operation can be used to help

selecting the most significant
classification measurements

Calculating the Weights of Classification Measurements
22. The nucdlei are classified and color coded

L L

Classified Nuclei

23. Press the Data Table Button in the View Group if the Measurement Table is not
displayed.

24. Select the Grouping drop down in the Measurement Table and set the Totals to
Average and set Show Collapsed as active.

Measurement Table
M- E
B Chsity by Grow

|v[ Show Collapsed e A

Set Measurements Table Display

25. Press the Grouping Button to display the collapsed data table.

Measurement Takie

O M x-% -

=

Izl

Data Results



Intensity Tracking

Create tracking regions

1.

From the Celleste™ Demo Images location, select the Endocytosis-pHrodo™

vesicles folder and the “Endocytosis-pHrodo™ vesicles.tif” image. The image is a

multi-tif time series and will play as a movie in Celleste™.

Mote: If each time point image is a separate image, the individual images may

be opened automatically as a movie within Celleste™. Use File/Open and go the

image folder containing the images. Select all of the images in the time series

using either Shift/Click or Control/Click. Check the Open As Sequence option as

shown below in the File Open dialog box and the images will open as a movie
within Celleste™.

7] Open Best Fit [¥] Open As Sequence

Open As Image Sequence Option

2. Select the Measure Tab.

3. Click on the Intensity Button in the Tracking Group.

Objects Intensity

Tracking

Tracking Group

. A new Intensity Tracking Ribbon will be displayed in Celleste™.

o brage Ansbyoc Safhe

Home Adjust Prozess Select Coert)Sze Measare Share View Agtomate dpgz [ neensty Tracking
1 C k‘ @ V¥ ToseTese Dt Histogen u
M T§oejec Task [ 0ot Gragh

Tipes Qoo Chose

St Veas. Optom Datx Ve Com

Intensity Tracking Ribbon

. Press the Types Button in the Measurements Group.

. Select the Region parameters needed for the experiment. Since the regions for

this type of analysis will be fixed, do not select any morphological parameter
since they will be the same for each fime point.

For this exercise, select the following parameters:
Regions: Area

Regions: Intensity Blue

Regions: Intensity Green

Regions: Intensity Red

E‘ @ & Toaatane \mDataHistogam

M  TRoveaTave [ DataGraon

Types| Optiors Cloz=
v W
| Analizble Measurements e Selected Measuremant :}
i [_An_lp: »37[An Categories |- || (& JEL Meaiure
Diameters - U Add All - Regions: Area
Dirgction - Regions:intensity Blue
Founer Descnptor U Remaove - Regons:intenssty Green
Fradtal Dimension MK Ciear Bl regonsinensityRed
Molz Arza Ratio
Hole Indices

Holes, Number of

I-Formed Boundary

Integested OD

intensitysive |
Intensity Green

Intensity Red

Intensity, Mean

Intensity, Min

Intensity, Std Dev

CEEEREERENACZOURE

Length




Intensity Tracking

7. Select the type of drawing object which will be used to analyze the cells. 8. Draw the regions on the cells or areas of interest.

Adjust

I+l ¢ - e
X\ 4|1O|O
S0 L
Select |Measwr..|  Optiors

Drawing Tools

Active Outline

With the outline active, right mouse click on the outline to display a tool set Defined Regions
containing the Poly Nudge Tool as shown in the image below. 3 i A 5 <o
; Note: If you make an error in drawing the outline of the region, it is not
.o Types C necessary to delete it and start over.
: k - Press the Select Tracks Button and click on the cell outline to make it active.
Select Measur..,

Select
k Selecttracks

Select Button




Intensity Tracking

Select the Poly Nudge Tool Button and adjust the outline by holding down the
left mouse button while adjusting the outline. If you need a large or smaller tool,
use the wheel mouse to adjust the size of the tool.

Turn off the Poly Nudge Tool by a right mouse click to display the main tools
control and clicking on the Poly Nudge Tool Button to turn it off.

Adjusting the Region Outline

9. The intensity tracking information is automatically calculated when the data is
displayed. Select the Data Table and Data Graph from the Data Views Group.

[llDataTable | |jData Histogram I" '

? Object Table Lj Data Graph
Close

Data Views Close

Velcome @ |E os e

Show Data Table.

o~y
‘o4

Data Views Group

N 10| [dt saartian cptvat sttt - RN )
G A

*reiey ola

LR R N kT

L3
'“!4!
H

]

L

g
L8 il
£
"!
H

k

Data Displays
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Wound Healing

Use the Wound healing app

Celleste” includes two Apps that must be loaded in order to use them

1. Select the Apps Tab and press the Open Project Button.

File Home Adjust Process
Open
Center Project
Search Apps
Image Strip Open Project

Apps Tab

Load an app from a project
file

Se

2. Select the WoundHealing.ipx file and open it.

lge Analysis Software

Name

File name: WoundHealing.ipx

Benchmarking Tools
Cell

Debugging
Demonstrations
ParentChild

Projectl
TileNormalization
UserMeasurements
UserMeasurements2

White Balance App

+ WoundHeahng.ipx

Date modif

11720154

ed

TPM M

0.04 PM
0:04 PM i
0:14 PM

108 PM

Typ

0:04 PM  File folder

v | Project Files (".ipp,”.ipx) -

Loading the Wound Healing App

App

3. The Wound Healing App is now loaded.

Open

Center Projed

Search

o O

Wound
Healing

Apps

Loaded Wound Healing App



Wound Healing

4. Click on the Wound Healing App Button to launch the App.

Wound Healing B x
— Segmentation
-1 \
Auto Threshold [%) |100 e
- Options

¥V Prompt to set Calibration
[V Auto Save File Name
[T Save Data

[T Save Snapshot Sequence

Results —_—
Wound Area®) 0.000
Area Rate(®s/frame) 0.000
Edge Rate(pix/frame) 0.000
Time to 50%(frames) 0,000
ﬂl Measure Wound Healing
— Batch Processing |
|
Folder e i

Extension | tif."tiff |

a Batch Process Folder

——

Wound Healing App

5.

6.

Open the” beacon 65 run two.wmv” image from the Celleste™ Demo
Images' Wound Healing folder.

i T
@l b # Users » Pusiiz o FukiicDecuments b Cellstz Ceme bneger » Wound Hesling B [FORY |
- —

Orgenee v My toider
& Downlosds
& beam Pacs
L2 Drepros
B Desitop

8 Libases
|'#] Documents
.J' Wirc

o
¥ video:

e Computer
& Locnl Disk (1)
S meges Mmcck01) )
& noed Mmodk01) PR
Open ezt

Fianama: beacen §5 rur bwoavmy ~  AllReadabie fiac (png, " jpg, =

Qpen | 1 Canzel

Loading the Image File

The movie file and App are now ready to use.

Celleste™ Desktop



Wound Healing

8. An outline around the wound area is displayed on the image. The Auto
Threshold % may now be adjusted and tested by clicking on the Test
Segmentation Button.

AR
2! n

7. Click on the Test Segmentation Button to test the current threshold setting. The
Auto Threshold % may be adjusted higher or lower to correctly select the wound

- 9. Select the Options and click on the Measure Wound Healing Button to run the

analysis.
Wound Healing 2 x
Segmentation - e s t
Auto Threshold [ |1°° jj R Ul S

—Options

Wound Area(%) 42,756
Area Rate(®z/frame) 4.403
Edge Rate(pix/frame) 6.359
Time to 50%(frames) 11.355

M Prompt to set Calibration
M Auto Save File Name

™ Save Data

[~ save Snapshot Sequence

~ Results

Wound Areaf) 0.000
Area Rate(/Trame) 0,000
Edge Rate(pix/frame) 0.000
Time to 50%(frames) 0.000

Measure Wound Healing

Measure Wound Healing

Batch Pracessing

Folder I e
Extension | “UE" At
g Batch Process Folder

Test Segmentation Button

Measure Wound Healing Button
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[V Auto Save File Name
[~ save Data

[T Save Snapshot Sequence

—Results

Wound Area(%)} 42,756
Area Rate(%/frame) 4.403
Edge Rate(pix/frame) 6.359
Time to 50%(frames) 11.355

w; Measure Wound Healing

— Batch Processing

Folder |

Extension I*-tif;*.tiff

Q Batch Process Folder
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Celleste Image Analysis Software - beacon 65 run two™ (1/20) L=
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\ 1
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Wound Healing




Parent-Child app

Use the Parent-Child app

The application is designed to provide workflow for parent-child analysis

applications. The app allows the creation of parent-child projects which streamlines
the analysis and provides the complete set of relational data. In this exercise, you will

count the # of spots in each nucleus.

The images for this exercise will be handed out during the training session.

1. Select the Apps Tab and press the Open Project Button.

App Open
Center Projedc

Adjust Process

Search Apps

Se

Image Strip | Open Project

Load an app from a project
file

Apps Tab

2. Select and Open the ParentChild.ipx file located in the ParentChild folder.

Crganize New folder

4% Dropbox
B Desktop

4 Libraries
[Z Documents
3\ Music
| Pictures
B videos

o Homegroup

™ Computer
& Local Disk(C:)
& images (enede0l) 0
# lknives (\imcdcO1) (N:)

File name: ParentCrild.ipx

2|
=~ 0 8
Narme L " Dote modified Type iz
| . FarentChildipe 127/Z06 A PN Mediz Cybemetc,
= i | '
v | Buoject Files [*ipp.ips) v

I Open J Cancel ]

Opening the Parent-Child App

3. Click on the Parent Child App button in the Apps Group to load it.

Wound
Healing

i

Parent-Child

Apps




Parent-Child app

Parent-Child
Project

~0 Al s
CEG
Parent Image

OV X

Children

Analysis

Combine ||'$

jt\_;:

Class

Grouping IParent = Class

Statistics |None

Batch processing

-
g'z", V/ Start Batch

4. There are 4 groups of controls exposed in the App:

-
1. Project - the group that contains controls to Load \/ Save “'and Reset uprojccts.

S ﬁ_

¥% | Segment and Count

. .
2. Parent Image - includes controls to Load ¥ , Set v , Remove

— the parent image. Use Draw to draw parent objects outlines manually. Parent image contains

object that define outlines for child objects,

D, 0aa W X Clear K L
3. Children - includes controls to lead V , Add , Remove *% , Clear ™", Segment and

Count \ child images. Child image can be the same as parent or a different image with the same size

as parent image. Child images contain objects that related to objects on parent image.

4. Analysis - the group that includes controls for combining the images and analyzing the data.

5. The image pair consists for a Hoechst™ labelled nuclei (Parent) and Alexa 488

marker for DNA damage (Child).

Image Pair

6. Reset Project using the Reset Button.

7. Select the Hoechst™ to make it the active image.



11. Name the Class as Nuclei and use the All version of the Recipe Options as shown
below.

Parent-Child app

Select and Count S
1.. - Q -

2.|:| v Q v Background

Parent Image - ~
, & 1%

2P | B ey 2 1
@ V . \ S n K
- . —

Nuclei - ‘
Select Objects = T

Class (g X Q)

8. Click on the Set Button in the Parent Image section.

T Train and Save *1
@ ~opiyGlobal (@ SetGlobal O =
Mask and Overlay *
e HESMW " p Mask v |4 Createlmage
Set Parent Image Recipe Optiors &
9. Click on the Segment Button and select Smart Segmentation in the Count/Size . ; 9} r ;s i @ Auto Weight
e Brop| 3E

Color || Backg || Morpho | Custom

10. Reset the Count/Size Measurements and Class Groups, including Smart Accumulated

Segmentation. & L - A Size 15 E
GAII M Clear  , Record

@Reset " Filter




Parent-Child app

12. Use Smart Segmentation and the Count/Tools to segment the nuclei.

Note: These steps are setting up a workflow on how to correctly count the nuclei

(Parent Objects) and all Count/5ize settings are active,

e

m Home Adust Process Select
& Bright € rvana ¥ x ’ & 2| 2 &'ﬁ o Eth ok
‘s W fe | R @ &

L Data Histogram

Count/Size Measure Share

o Count Spit Types Edt |Ranges Optioms
i
Q Dark | %3y, Smart G = ~  Range () @ Cuject Window
Segmert Court x Spiit remerts View
2 }

Image Strip t Selecte |3 )

Select

View

l=d Image

Class 1]

Automate

Apply W B

Shape &

Class

Boundary Shape

Object Splitting

13. Use the Count Button in the Parent Image group. Once you are satisfied the
nuclei are correctly counted or as well as can be accomplished, the Count
operation will create a settings file associated with the Parent Image group and

will be saved with the project file if one is saved at the end.

Counted Nuclei

14. Select the Alexa 488 image to make it the active image and click on the Add

Button in the Children section.

Children —
e

PV E@ X
| Image Cl_ass_}

Children Group

15. Click on the Alexa 488 image and then click on the Segment Button in the

Children section.

Children
PO L@ X
Image Class

BT

Selecting the Segment Button



= 20. Select the Top Hat PLUS™ Filter and set the values to 5 for the Height and Width
P a. re n t_ C h I I d a.p p as shown in the screen shot below.

For this image, a little image processing is necessary to separate the foci from the

. o . background.
16. Click on the Segment Button and select Smart Segmentation in the Count/Size

Tab.

17. Reset the Count/Size Measurements and Class Groups, including Smart

Segmentation. Custom Channel Parameters

Charnel Type |Top Hat Plus Filter Width

18. Name the Class as Foci and use the All version of the Recipe Options as shown
below. For this particular image, there is one important change to the Recipe due Input |Gray Height
to high background in the Alexa 488 which obscures the foci. |

A Custom Channel will be added to help distinguish the foci from the

background. Caption |Top Hat Plus Filter
Select an_dCount 2
. ‘Cj‘ | Foci -
1M~ - (Select Objects = X
e : Cass X Q)
20~ () - eackgrourd Process in Float

@ @

Count o MM =

3
Adding a Custom Recipe Channel

Train and Save ®
@& 2op1yGlobal @ setGloba @ g
Mask and Overiay . 21. Select the foci and background as normal by defining the reference areas on the

“H—' Show ~

image. Use the rest of the Count/Size settings to properly count the foci. Press the

B toask - S i Count Button in the Children section to count the foci.

Recipe Optiors £
ﬂ ¢ v l EE' [ Auto weight 22. Click on the Combine Button. The Grouping in this section should be set to
." Top[ 3 Parent + Class.
Color || Backg || Morpho || Custom Orop
[£] Accumulated
. e———=_Emn R ———

[ Add new channel

A | NS | s |
QAII 'Vé\a;\ddne;;;:-d .Combine \‘i |’.x.f ﬁ :.' ‘

Q Reset Filg Adds user-defined channel ‘
Recipe S O 6ok s Groupin Parent = Class -
ecipe Summary -hannels usingfilter or 4+

arithmetical operations. ping i |

Statisticl Combine parent and children measurements for analysis.

U

Adding a Recipe New Channel
Combining the Measurements

19. Under the Custom Button, select Add a new channel.



Parent-Child app

23. The results and image overlays are now displayed.

led 2iexs 4gatir O lidHoeahsttic ©
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E
n!’

Results



Live/Dead Cells App

3 Open one of the Raw Images from the “Live Dead” dataset. Ensure group related

Analyze multi-well plate data using the Live/Dead cells app filosis salacted.

1. From the “File” menu select the application options (which you find at the

bOl‘tOI‘n I‘ight Of the Fi].e menu) 1+ » ThisPC » DATA(D:) » Documents » EvosFiles » Live Dead v U

Oiganize v MNew folder

2. In the Image options ensure that “Auto Tile” is selected. 3 - i :
[ Celleste Image Analysis Softwa T T

&) LiveDead2 Plate M p00 0 H111C1d0.TF

& mediecy.com
| LiveDead2_Plate_M_p00_0_H11{02d0.TIF

Set Display

& ThisPC ] LiveDead2 Plats_M_p00_0_H11{0340.TIF

- p

cot =i 5 %
Defsult Set DISD‘?/ |mage P 3D Objects |&| LiveDead2 Plate_M_p00_0_H12fC0d0.TIF
[ Desktop [&] LiveDead2_Plate_M_p00_0_H12:01d0.TIF
| Color Composite Display = Documents 5,_1 LiveDead?_Plats_M_p00_0_H12{0240.TIF
I 7| Auto Tile I 1‘ i dasde I‘L_y‘ LiveDead?_Plate_M_p00_0_H12{03d0.TIF
&) LiveDead2 Plate R 520 0 AC1FOCLOTIF
h - i _Flate | 0.

Flip Lef-Figt ) Bl W] LiveDeadd_Platz| F_n00_0_AOTFO0 TIF
Flip Top-Bottom &) Pictures W] LiveDead2_plate|R_nD0_D_AOTFO0CI3 TIF
7| Blend Overlaps {8 Videos &) LiveDead2 Plate|R 000 0 A0TfO1dO.TIF
E 0S(C) | LiveDead? Plate!R_o00 0 AOTF01d1.TIF

Select a Raw Image (with “_R_" in the
name. Ensure Group related files is

All Readable Files (*.z3d, ".png,

enabled.

Open Cancel

The dataset will open with the plate viewer displayed in the details panel on the
right of the application.

4. Make well A5 the active well.



Live/Dead Cells App

5. Select the “Apps” tab.

9. Set the Total drop down to the DAPI channel, and the Live Drop down to the
6. Click “Open Projects” and select the LiveDeadCells.ipx (this is located in the GFP channel.

default scripts folder (C:\ Users\ <Current User>\ Documents\ C elleste™

5\ Scri o . .
\Scripts\ LiveDeadCells) Live/Dead Cells 2
7. |Z| Click on the Live/Dead Cells icon on the Apps ribbon. 8 © Q =
Live/Dead Cells 2 x Experiment Setup
e e G Cpen 7] Show DC
Experiment Setup
2 Open 1] Show DC Kit Custom = m'
Read channel names
Kit Custom - '
Total DAPI %
Total  GFP 2
M o e - Live GFP -
Dead  TXRed -
i Dead TX Red =3
/| Interactive
Auto Tile -
|
Stort Bxperimnt ‘/ 10. Click Start Experiment.
8. Set.the' kit to “Custom” and click on the option to “Read channel names from the Start E Xp eriment >
active image.




1.

Live/Dead Cells App

The App will display the Segmentation options tor the Dapi channel and ask you
to set a threshold that separates nuclei from the background. Click Ok in the “Set

Thresholds” dialog when you are tinished.

1 b x  Measure OK

& Set Thresholds

Cancel

|/ Thweshora Toot RT %X |

L @ [~ sShow - @

W Count I

Adjust

the threshold

1500 2000 2500 3000 3500 4000

0 500 1000 35
A~ san 21 35| | @
) &) End 053 U @

12.

13.

14.

15.

16.

Click on the “Adjust measurement area interactively” button to access the Edit
Measurement Range dialog. Set upper and lower limits for nuclei area.

Live/Dead Cells Q
4;‘ W W New
Segmentation
Channel DAPI (Talal)
Intensity Threshold 2112 @
Minimum Size 0002

Adjust measurement area interactively

Edit Measurement Rance 7 P4
B RegionAres ~|Bins| 2120 G & |
Nin Max
4
100 H
:
50
200 400 00 800 1000 4200 1400 4500 1800 2000 2200
/| belive Min 05
(PReset Mo 1.00E+308 5] | Apoly Filte

Objacts i range 302/302
(100.00%)

Apply on Close Ok

Set the Auto-Split option to the most appropriate setting and select Clean

Borders if appropriate.

Click Next SegmentationGFP.

MNext Segmentation GFP

Select appropriate segmentation settings for GFP repeating the workflow that

you implemented for the DAPI channel.

Click Next Results.

Mext Results

The data collector is populated with results. You have the option to save the
annotated results image or the experiment template.



Live/Dead Cells App
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17. We are interested in analysing the entire plate so click finish.

18. Set the active range of the plate to Row A or B.

Plate Viewer
A 1|2
A OO
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Live/Dead Cells App

19. Deselect the Interactive option and select the Batch mode option. ,
21. Export the data to excel.
Live/Dead Cells 3 x
© O O & New
- - ollect=
Experiment Setup 7 lveDeaqz Fat. 406 2B 30,000 90.099 3,901 303,000
ot 3 1 lects 5 N e " <
E{:’ Open & Clear DC ) o Show m & liveDead?_Plat. 407 2o 295,000 308471 64,150 428000
dc n_r:i: ZJ . & ‘ .
Klt C Ustom & ﬂ | P .“Q liveDead2 Flat. 408 5033 3.?-1.?30 111-1 7 SS%J; :iﬂ 03?
- llect=: |
1€ liveDead2 Flat., A0S 32.000 443.000 6,667 93.333 480.000
Total DAPI - e ow Ao .3 sace
ol Collect®: 11
17 UveDeactZ_Fiat.,. A0 .00 455,000 6.250 93.750 496.000
Li\;e GFP - Y -‘/:V:VJ': 1 21.000 465.000 625 = 8750 0 496000
12 liveDead2 Flat.. 411 31.000 435.000 6.652 93.348 466.000
Dead TX Red - S w5, ' i o P
13 UveDead2 Flat. Al2 41.000 535.000 B34 93,553 636.000
Interactive /| Batchmode 2 Eoteaei W
14 UveDeadz Flat. EC1 0.000 321.000 0.000 100,000 321.000
AveragelT) 0.C00 321.000 00 100000 = 321.000
AL‘tO T”e J Sho“' Steps s 3 15 liveDead2 Flat. EC2 2000 404.000 0.493 94,507 406,000
“ 1€ liveDead2 Flat.. EC3 3.000 420.000 2098 §7.902 425,000
Run Experiment 7

20. Click Run Experiment. The whole plate will be analysed.

Run Experiment




Data Collector



Data Table

Line Graph

ses Regions:Intensity, BW = i

2000 ; .
' »
1500 - osiaan
1 N \
1000 - >

500 -

Regions:Intensity, Mean

%z -'gllndex' 1k
Rl (Index) Intensity, Mean Intensity, Max Intensity, Min
8 1 75.54 143.00 0.00
8 2 65.65 190.00 0.00
e 3 64.21 194,00 000 |=
& 4 5247 176.00 0.00
® 5 4267 186.00 0.00
o5 31.10 131,00 000
e 7 24.96 36.00 0.00
® 3 16.15 37.00 poo ¥
4| i
Mean Value 4237 12511 0.00 &
Standard Deviation 2232 66,50 000 | _
Minimum 8.55 33.00 000 |
Maximum 75.54 194,00 0.00
Range 66,99 161.00 0.00
w
| Histogram
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Colled Types

v 5 -

Da
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=

"1l Data Table [h Histogam

E Block

333D

~. Graph

Collector

s*, Scatter

Data Collector Group

i @ 9 [lDataTabke |MHistogem 4@ &F
'f' [: Block L':_. Scatter '_‘ 5
Types Objects Intersity
‘ - U tGraph @30
Available Measurements
W W [Alldataprovides jjl Find
o ta vid 0da 1
Table: f atior
3 Provi Histogram
T e Histogram
4] Table: Histogram Values
ata Provider: Imag
J} Tabl Act Fram
+] Table: File
+l Tab Ima
Table: Inten Ca
] Tab [ Calibrat
2 ta Provide age Set
&l Te Display Reg
| Tab Ima
sta Provide n fi
HT Ed ment

Selected Measurements

Collect®
DisplayName
Active Frame Index

Active Frame Number

U-’ldd/\” =] Table: Measurements

Collect=

Feature Name

S Clear B Object:Class Name

u Region:Area

U New EJ Region:Diameter, Mean

‘ - Regiomnintensity, Mean
B Region:Roundness

srrrrinne

Data Collector Types

‘g N ‘@ ¢» T'llpataTable |MHistogram

‘[ Block *, Scatter
Colled Types

- « W B Graph
Data Collector

pEET

Collect data from all registered
data provigers.

Collect Button




7! x EJ ¢» Tl pataTable | Histogram
:
.

2

4 THBlock =, Scatter
Colled Twpes Objects Intensity
- « @ EGrapn ®3p
Data Collector \ Tracking

Data Table

Show table view with all
measurements.

——
‘ ;"‘f"‘

Bes |

Data Table Button

= .
rFeature Name | [ Doject:Ciass Name - Feq oniares E’ Reglon:Diameter, Mean . kig tonntens m, Mean E weg 0 ROUNTNESS
S S e iy S— : —— - ey e eyt e e et et
1 PIR2 Celis 1.292
1 PIRS Celis 122548 11604 511630 1.042
1 PLR4 Cells 176 589 14 206 614 858 1.000
1 PIRS Celis 26.541 4557 164 086 2.131
1 PLRE Cells 150.247 13166 630257 1.108
1 PLR7 Cells 32.608 5372 171326 2.2%
1 PLRB Cells 28058 6174 173351 1.666
1 PIRS Cells £1.140 9.293 432121 1.212
1 PLR10 Cells 147114 12850 667.351 1.057
1 PIR11 Celis 104648 10710 390.783 1043
1 PLR12 Celis 101,515 10573 299425 1.033
1 PLR13 Celis 102373 10,548 468.748 1.027
1 PLR14 Celis 28058 6097 169822 1.551
1 PLR1S Cells 71.282 8746 272.266 1040
1 PLR16 Celis 137.256 11966 389602 1.27%
1 PLR17 Cells 2100585 15432 415939 1.215
1 PLRI13 Cells 147573 12785 515.000 1.067
1 PLR1S Cells 51324 7.226 165638 1351
1 PLR20 Cells 82057 9473 375.706 Lo21
1 PIRZ1 Cellis 151664 13077 511.790 1031
i Measurements (= Tmage

Data Collector Results




Set up Data Collector for accumulating statistical information

1. Delete the current data tfrom Data Collector data table by pressing the double red
X Remove All button.

9

Colled

v

X ‘@ &} | Tl DataTable
N [

2% = _E] Block
Types

m + A
Data Collector

~~ Graph

|y Histogram
l-L: Scatter

@ 3p

l Remove All

Remove Data

\a’/ collectar.

Remove zll data from data

2. Click on the Data Collector Types button again. Under the Available
Measurements on the left side, use the drop down to select the Measurements
provider. For this exercise, only the Data Provider: Measurements will be used.
Select the Measurements provide from the drop down as shown.

Available Measurements

O @ |Andataprovides  [=] [Finc

3 Dat qzq_, Measuremenis
. |@ Colocalization
= T’.":: Tracking
=) Data 8= Line Profile

| Taded Image
_L;.)[magefet
Ly Histogram
| All data providers
Table: Active Frame

) Table: File

able; Image

able: Intensity Calibration
able: Spatial Calibration
)ata Provider: Image Set

+l Table: Display Region
able: Image Set

ata Provide Line Profile

| Table: Edge Measurements

| -2
‘UAudAn ‘
|

Selected Measurements
Measurement Name
=l Table: Image
Collect®
DisplayName
Active Frame Index
Active Frame Number
=) Table: Measurements
Collect® J
Feature Name
B8 Object:Class Name
u Region:Area
a Region:Diameter, Mean
- Region:Intensity, Mean
B Region:Roundness

Data Collector Types




Set up Data Collector for accumulating statistical information

4. Select the Display Name in the Measurement Stats section on the left side and
press the Add button. The Display Name will report the actual image name in
the data table in order to keep track of which image the data was generated from.
Notice there is now a table called Table: Measurement Stats under the Selected
Measurements group on the right hand side.

3. The exercise will use the Table: Measurement Stats parameters. Toggle the little
widget next to Table: Measurement Stats to expand the list of parameters.

Selected Measurements ——— | X |

Y
l uS/nC Measurement Name -

|————— Available Measurements

(O Y l‘f,@Measuremeris BHF”?

Feature Name

- Angle:Center Y

=l Data Provider Measurements Count - | | =) Table: Image ‘ Available Measuremerts ‘ Selected Measurements (x]
/ - 5 = |
+] Table: Measurement Class Stats " Enliecp - W W "&; Measuremeris ﬂl' nd ‘ ‘ g Sync i Measurement Name ¥
i3 ¥ ‘ H U Add DisplayMName v — | [=
i+l Table: Measurement Stats 3 Data Provider  Mansurements o [oud = Table: Image
) Table: Measurements o Stats Active Frame Bulex 4+ Table: Measurement Class Stats = ‘ ) o ¢
- Active Frame Number J S ble easUreraenE Shate | & Aad DisplayName v
O Add All =l Table: Measurements B Angle:Angle | ' Stats Active Frame Index
Collect= J - Angle:Center X Active Frame Number

UAddA” || =) Table: Measurement 5tats %

" . ius Collect# v
B¢ Crear B object:Class Name J B8 AngleRadius s ; :
: P BestritMax Distance DisplayName v
: - Region:Area v ; v s = [ AT R N
New . : BestFit:Mean Distance &K Clear = Table: Measurements
ﬂ Region:Diameter, Mean = Collect#
BestFitMin Distance y i
ion: i / e -
Edit - Region:Intensity, Mean J BestFItRMSE u Fga-ture N g
Bl region:Roundness Cotlect Time - B8 Object:Class Name
Collects B Region:area /
{ DisplayName EB Region:Diameter, Mean
B Line:angle DisplayName i o tatansity, Mean

Measurement Stats

u Line:Arc Angle

Selecting Display Name Parameter

Type
Descn

System. String

ndness

Name : DisplayName

phon :
Expression © Parent(Image_MeasuementStats) DisplayName




Set up Data Collector for accumulating statistical information

5. From the Measurement Stats section, add the Object: Class Name.

For all other measurement types, a specific sub parameter will be chosen. Add
the Region: Area type and select the specific Count parameter from drop down
list in the center column to keep track of the number of cells per image.

Region: Intensity Mean/Mean
Region: Roundness/Mean

Available Measurements

. Qe |°,(, Measurements i] Ip;.,

Selected Measurements —— |

‘ QS)’”C Measurement Name v

———————— Availabie Measuremerts — —

; QG [2’ Measuremernis 3 lrF nd

- Point:Location X a || lcount m =) Table: Image

- Point:Location XY Mean Collect# v
- Point:Location ¥ i StDev DisplayName 7
- i e | Min Active Frame Index

a Region:Area Polygonal Uncalibrated ;:r:ge Active Frame Number v
- Region:Area Uncalibrated _{| | sum =) Table: Measurement Stats

u Reglon:Area, Polygonal | iMin Collect® J
n Region:Aspect Ratio gz\t DisplayName 7
- Region:Axis, Major lwmy— =) Table: Measurements

B Region:Axis, Minor ¥ ‘ Collect# ,”'
£ Region:Bound Box Height U S | Feature Name v
£ Region:Bound Box Width ear | N object:Ciass Name 7
m Region:Box Area - Region:Area J
n Region:Box XY E’ Region:Diameter, Mean 7
®  Region:Branch Lengths B Regioniintensity, Mean 7
u Region:Caliper, Max ‘ B Region:Roundness v

Adding a Measurement Type Sub Parameter
Add the following parameters:

Object: Class Name
Region: Area/Count
Region: Diameter Mean/Mean

- Rzgionintensity, Mean

- RegioniIntensity, Min

B Regionntensity, sta Dev

n Rzgion:length

ﬂ Region:Marginatien

- RegionNest Parent Index

- Region:Nested Child Indices
- Region:Nested Children Count
B regionnesting Depth

0 Rzgion:Mum End Points

E:E Region:Parent Fezture Index
[ regionPercent Arza (3%)

m Region-Percent Arza (Ratio)
¥ RegionPercent Arza Parent
[ regionperimeter Ratic

n Region:Perimeter Uncalibrated
n Region:Penmeter, Bounding Pixels

n Region:Perimeter, Bounding Polygon

a Region:Perimeater, Convex Hull
EM Region-Perimeter, Equiv. Ellipse
B regionradii

ﬂ Rzgion:Radius Ratio

E# Region:Radius, Mix

£ regionRadius, Mn

E Region:Relative Size

g Region:Roundness

- Region:Saturation
EM r-gionsize count
M Region:Width

B regionnQ color 1
m RegionVIQ coler Q
m Region¥Q colar ¥

2 Tible: Mecsutenienils

v

i O Sync

Mean -
Qs
o Stats

O Acd Al

REMOE

Selected Measuremens ——| X |

Mzasuremen: Name

.;I Table: Image

Callect®
DisplayName
Active Frame index
Active Frame Number
=] Tahle* Measvrement State
Caollec#
DisplayName
B Obj=ct:Cass Name(Mean)
n Region:Area(Count’
n Region:Diameter, Mean(Meary
- Region:Ihtensity, Mean(Mean,
g Region:Foundness Mean)
=l Teble: Measurements
Colled#
Feature Name
ﬁ Object:Cass Name
u Regian:irea
ﬂ Region:Diameter, Mean
- Region:lntensity, Mean
B Region:Foundness

s

Selected Measurements

rrEsiE




Set up Data Collector for accumulating statistical information

6. Uncheck every box on the right side, except those under Table: Measurement AR5 W M e T b e R A
Stats. Onlv {1 tvelv checked p ¢ 11l be displaved in the Dat button is pressed, the data from the active image will be sent to Data Collector. It
ats. Y the acuvely chiecked paraineters wi € displayed 1 the Lata the Automatic Collect feature is active, the data will be sent to Data Collector
e R s ] = - == =
= A=1EAFE-5
Measurement Name ® Collect= Display Name [l Otject:Class N... |l RegioniareaiCount)  |EJ RegionDiameter, MeaniMean) |l Regioninter = u Mean)
1 A549_0.6um_Liv.. 485.000 11949 363742 1.149
= Table: Image
Collect=
DisplayName
Active Frame Index ia Meas wement Stats
Acti s
chive Erame Nimbes Measurement Statistics
= Table: Measurement Stats
Collect® J 9. Click on the Save button in the Data Collector Group and save the Data Set file.
DisplayNa = For this example, name the file “Cell Summary”.
isplayName
! Object:Class Name(Mean) J B =
- RCgIOﬂIAfCB‘COUnt] v (]K/ | <« jmip=MELOCAL » My Documents b Cellestend-Ed 0 &1 b Configiration Files
:'] Region:Diameter, Mean{Mean) v Oiganize v New folder
- Region:Intensity, Mean(Mean) / ‘ ::.::Ito;ldac: Qs - ) :IJ L =
B R x C %3 Dropbox __| DataCollectorMeasurements.adoxsd 2 l 4 -u -.r._/ _f »x—.
egion:Roundness(Mean) v o i __| Cell Count.adoxsd 2/273/20171:12PM  ADOXSD File
| Table: Measurement:
4 Libranes = |
Collect= & Documents
;1 Music 3
Feature Name i Pictures
g Object:Class Name B videos
& X & Computer
n Reglon.Area & Local Disk (C:)
B Region:Diameter, Mean 3t mages (\umcdkl
- Region:Intensity, Mean File name:  Cell Summary
g- AT i css SRS EREREA R - ; Saveas:ype:{DalaSe{'.adonsd)
= Hide Folders

Data Collector Save As
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Batch processing Beginner's guide to macro writing
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